Contents

Preface ................................................................. vii
  Audience ............................................................ vii
  Goals ...................................................................... vii
  Conventions ........................................................ vii

1 Introduction to Maple T.A. ................................. 1
  1.1 Product Overview ........................................... 1
  1.2 Creating a Class Home Page ......................... 2
  1.3 Logging On ..................................................... 4
  1.4 Main Menu ..................................................... 5
  1.5 Navigating ...................................................... 5
  1.6 Accessing the Help System ......................... 5
  1.7 Avoiding System Time-Outs ......................... 5

2 Question Banks .................................................. 7
  2.1 Overview ....................................................... 7
  2.2 Question Bank Editor ....................................... 8
  2.3 Creating a Question Bank ............................... 9
    Starting a New Question Bank ............................ 9
    Adding a Topic .................................................. 9
    Adding a Question ............................................. 9
    Question Types ................................................ 10
    Equation Editor ............................................... 11
    Installing a Question Bank ............................... 12
  2.4 Example Questions .......................................... 13
    Multiple Choice ................................................. 13
    Multiple Choice Question Using the Equation Editor 14
    Multiple Choice Question with Randomly-Determined Parameters 17
    Maple-Graded Question ..................................... 19
    Plotting the Student's Response ....................... 21
    Inserting a Maple Plot in Question Text .............. 22
    Apply Partial Grading to Maple-graded Questions .... 22
    Inline Questions .............................................. 23
    Visual Editor ................................................... 23
    Overview of Authoring Inline Questions .............. 24
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline Examples: List and Formula Questions</td>
<td>24</td>
</tr>
<tr>
<td>Symbolic Math in Inline Questions</td>
<td>27</td>
</tr>
<tr>
<td>Exporting and Saving Files</td>
<td>27</td>
</tr>
<tr>
<td>2.5 Editing an Installed Question Bank</td>
<td>28</td>
</tr>
<tr>
<td>2.6 Backing up a Question Bank</td>
<td>28</td>
</tr>
<tr>
<td>Downloading a Question Bank to Your Hard Drive</td>
<td>28</td>
</tr>
<tr>
<td>Opening a Question Bank Downloaded to Your Hard Drive</td>
<td>29</td>
</tr>
<tr>
<td>3 Assignments</td>
<td>31</td>
</tr>
<tr>
<td>3.1 Overview</td>
<td>31</td>
</tr>
<tr>
<td>Assignment Editor Main Menu</td>
<td>32</td>
</tr>
<tr>
<td>Warnings and Locking Mechanism</td>
<td>33</td>
</tr>
<tr>
<td>3.2 Creating Assignments</td>
<td>33</td>
</tr>
<tr>
<td>3.3 Naming Assignments</td>
<td>34</td>
</tr>
<tr>
<td>3.4 Selecting Questions</td>
<td>34</td>
</tr>
<tr>
<td>Individual Versus Grouped Questions</td>
<td>35</td>
</tr>
<tr>
<td>Individual Questions</td>
<td>35</td>
</tr>
<tr>
<td>Question Groups</td>
<td>35</td>
</tr>
<tr>
<td>3.5 Setting Policies</td>
<td>35</td>
</tr>
<tr>
<td>Assignment Types</td>
<td>36</td>
</tr>
<tr>
<td>Assessment Type Assignments</td>
<td>36</td>
</tr>
<tr>
<td>Study Session and Mastery</td>
<td>38</td>
</tr>
<tr>
<td>Setting the Assignment Type</td>
<td>39</td>
</tr>
<tr>
<td>Assignment Visibility</td>
<td>39</td>
</tr>
<tr>
<td>Assignment Feedback</td>
<td>39</td>
</tr>
<tr>
<td>Assignment Properties</td>
<td>40</td>
</tr>
<tr>
<td>Setting a Passing Score</td>
<td>40</td>
</tr>
<tr>
<td>Setting a Time Limit</td>
<td>40</td>
</tr>
<tr>
<td>Setting the Number of Questions per Page</td>
<td>41</td>
</tr>
<tr>
<td>Setting the Maximum Number of Attempts</td>
<td>41</td>
</tr>
<tr>
<td>Scheduling Assignments</td>
<td>41</td>
</tr>
<tr>
<td>3.6 Reviewing and Saving Assignments</td>
<td>42</td>
</tr>
<tr>
<td>Finishing an Assignment</td>
<td>42</td>
</tr>
<tr>
<td>Assignment Status</td>
<td>42</td>
</tr>
<tr>
<td>3.7 Special Cases</td>
<td>43</td>
</tr>
<tr>
<td>Deleting Assignments</td>
<td>43</td>
</tr>
<tr>
<td>Shared Assignments: Saving Your Changes</td>
<td>43</td>
</tr>
<tr>
<td>4 Gradebook</td>
<td>45</td>
</tr>
<tr>
<td>4.1 Overview</td>
<td>45</td>
</tr>
<tr>
<td>4.2 Gradebook Views</td>
<td>45</td>
</tr>
<tr>
<td>Generating Reports</td>
<td>46</td>
</tr>
<tr>
<td>4.3 Student Statistics</td>
<td>46</td>
</tr>
<tr>
<td>Assignment Weighting</td>
<td>47</td>
</tr>
<tr>
<td>Changing Grades</td>
<td>47</td>
</tr>
<tr>
<td>4.4 Assignment Statistics</td>
<td>48</td>
</tr>
<tr>
<td>4.5 Item Statistics</td>
<td>49</td>
</tr>
<tr>
<td>4.6 Administration</td>
<td>50</td>
</tr>
<tr>
<td>4.7 Class Roster</td>
<td>51</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Uploading a Class Roster</td>
<td>51</td>
</tr>
<tr>
<td>Student Registration</td>
<td>52</td>
</tr>
<tr>
<td><strong>5 System Tools</strong></td>
<td>53</td>
</tr>
<tr>
<td>5.1 Overview</td>
<td>53</td>
</tr>
<tr>
<td>5.2 Uploading Files</td>
<td>54</td>
</tr>
<tr>
<td>5.3 Shared Classes</td>
<td>55</td>
</tr>
<tr>
<td>Creating a Shared Class</td>
<td>55</td>
</tr>
<tr>
<td>Shared Class Content Updates</td>
<td>56</td>
</tr>
<tr>
<td>5.4 Course Modules</td>
<td>57</td>
</tr>
<tr>
<td>Creating a Course Module</td>
<td>58</td>
</tr>
<tr>
<td>Saving A Course Module</td>
<td>58</td>
</tr>
<tr>
<td>Uploading and Installing a Course Module</td>
<td>59</td>
</tr>
<tr>
<td>Additional Notes</td>
<td>60</td>
</tr>
<tr>
<td>Inheritance of Question Banks and Assignments</td>
<td>61</td>
</tr>
<tr>
<td><strong>6 Additional Resources</strong></td>
<td>63</td>
</tr>
<tr>
<td>6.1 Maple Application Center</td>
<td>63</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>65</td>
</tr>
</tbody>
</table>
Preface

Audience

The information in this guide is intended for instructors using the Maple T.A. system for the first time.

Goals

This guide serves as an introduction to the Maple T.A. system. The first five chapters provide information related to each component of the system. Where relevant, examples are included. The sixth chapter provides additional resource information.

Initially, the chapters should be read in sequence. This provides a linear introduction to the process of using the components in the Maple T.A. system. However, this guide can be used as a quick reference or as a launching point for the Help system. For your convenience, this guide also includes an index.

Conventions

This guide uses the following typographical conventions.

- **Arial bold font** - dialog, menu, or text field
- **Arial bold Important** - information that must be read and followed
- **Arial bold Note** - additional information relevant to the section or procedure
- **Century Schoolbook bold** - new term
- **courier font** - Maple command or package
- **italics** - section or Help system cross-reference
1 Introduction to Maple T.A.

1.1 Product Overview

Maple T.A. uses **question banks**, for example, questions from class homework, test items, or other class problem material, as the basis for constructing **assignments**.

Four types of users interact with Maple T.A.

- Instructors create questions and assignments.
- System administrators manage system preferences.
- Students complete assignments created by instructors.
- Proctors validate student identity and grant assignment access.

As the instructor, you control the rules and policies for assignments, which can range from self-study and homework sessions to proctored exams. When you are satisfied with the questions and rules in your assignment, you publish it for use by students. You can control availability and due dates, and set grading parameters. Grades are automatically recorded in the system **gradebook** and, if necessary, you can change these grades.

Your Maple T.A. class has its own **Class Home Page** URL, which is the entry point for all system interaction for you, the instructor, for your students, and for the proctors in your class. Your class contains question banks, assignments, resource files, and the class gradebook, and also gives you access to several system tools.

**Students** visiting your Class Home Page are allowed to register in your class, select assignments as you make them available, and review the results of assignments they have completed.

**Note:** As an instructor, you can lock access to student registration. Instead, you can upload a class roster. For details, see **Class Roster** on page 51.
Class **Proctors** can log in from your Class Home Page to validate a student's identity prior to administering a proctored exam.

Instructors access the **Class Home Page** to:

- Create and edit question banks
- Create, publish, and manage assignments
- Access a gradebook that records student work and assignment results

**Figure 1-A Class Home Page**

### 1.2 Creating a Class Home Page

You or your system administrator creates a unique (new empty) class Web site or one based on shared material.

To create a new class home page:

1. Start at the server root address. For example, http://servername:port.
2. At the root address, you are given the following options:
   - **System Administrator**
   - Register for a new class
   - Find your class
3. Click the **Register for a new class** link to begin the class registration process.
4. From the **Select Class Template** drop-down list, select a class template or **Root Empty Class** and click **OK**.
5. Enter your registration code.
   
   The registration code is the alphanumeric password that authorizes you to create a copy of a shared class or to create a new, empty class. You obtain it from the person sharing the class or your system administrator.

6. Complete the class registration form and click Finish.
   
   **Class Name**
   
   Select a unique name for your class, which is displayed as part of your Class Home Page. The class name should be between 5 and 50 characters long. It cannot contain the characters <, >, or &.

   **Instructor Name**
   
   Enter your name. On this system, a name can only contain the alphabetic letters A through Z, together with “-” and “‘”. The first character must be alphabetic. The middle initial can be empty or a single alphabetical character.

   **Email Address**
   
   Enter your email address. This field is optional, but recommended.

   **Password**
   
   Select a password to access your Gradebook and create assignments. The password should be at least 5 and no more than 12 letters or numbers. Spaces are not allowed. For your security, the password does not display on the screen. To confirm the correct password, enter it twice.

   **Class Home Page URL**
   
   You must select a unique home page URL for your class. The system informs you if you have chosen a duplicate URL. Select a short string of letters or numbers that will make an easy-to-remember home site for your class. You must use between 3 and 16 characters, but only a through z, A through Z, and 0 through 9 are allowed. No punctuation, spaces, or special characters can appear in a Class Home Page URL.

7. The Registration Complete screen opens, displaying the link to your class. Click the link to open your Class Home Page. You can login as instructor and (if based on a shared template) review the contents of the class.

   **Note:** Add this link to your browser favorites.

**To create a copy of a shared class:**

1. You must be provided with a Class URL, a registration code, and browser instructions to navigate to the specified Class Home Page.

2. Navigate to the specified Class Home Page, and use the Instructor Login to proceed to the next screen.

3. Click the Register a copy of this class link to initiate registration of your shared class.
4. When prompted, use the registration code you were provided to create your new class, which contains all the question banks and assignments of the shared parent class.

1.3 Logging On

Whether your system administrator provided you with a Class Home Page URL and instructor login password, or you created your own class home page, open a browser and navigate to this site.

The Class Home Page displays the class and instructor name, and the following links for students, instructors, and proctors.

- Assignment list indicating the name and type of assignment, associated points, availability, that is, scheduled dates and times, and specific policies in the assignment, for example, time limit. Clicking the listed assignment name launches the assignment.
- Instructor login.
- Proctor login.
- Student registration via the Register as a student in this class link.
- Assignment results via the View my results in this class link.
- Quick links allowing you to search for a class or display a list of browser configurations.

To log into the Instructor Main Menu:

1. Click the Instructor login link. The Instructor Login dialog opens.
2. Enter the instructor password provided by your system administrator or that you created and click Enter. The Instructor Main Menu window opens.
1.4 Main Menu

The Instructor Main Menu provides access to the Assignment Editor, Question Bank Editor, Gradebook, and System Tools. When you place your mouse over the links, tool tips are displayed.

Figure 1-B Instructor Main Menu

1.5 Navigating

To navigate in the Maple T.A. system, use the system navigation buttons located at the left. Do not use the back and forward browser buttons.

1.6 Accessing the Help System

Click the help icon from any page to access online help for instructors. Your students can get help for students by clicking the same icon.

1.7 Avoiding System Time-Outs

While working on a question bank, the system client (your computer) holds your changes to the working copy of the active question bank. While authoring or editing a question in an assignment, if you click Finish, the system places a copy of your question in the class Web site cache.
However, if you do not interact with the system for the time set in the system properties file (for example, 12 minutes), the system logs you out of your session and purges the question bank data, flushing the cache.

If the system server is restarted, the cache is also purged. The system reverts to the last installed version of your question bank. You can also upload a version of the question bank from your hard drive to your client.

If you stop interacting with the system for more than a few minutes, it is recommended that you either:

- Download your question bank to your hard drive
- Install your question bank in your class on the server

The question bank’s persistence time is controlled by the system administrator. To change its value, contact your administrator.
2 Question Banks

2.1 Overview

Maple T.A. uses question banks, for example, questions from class homework, test items, or other class problem material, as the basis to construct assignments.

Question bank files are plain-text files, with a .qu extension, structured according to the Maple T.A. question bank syntax.

Question banks are organized into topics, which contain individual questions. Topics help organize questions to match the structure of your course. They can also indicate learning objectives and other organizational schemes. Every question bank has at least one topic, and every topic has at least one question.

Figure 2-A Question Bank Structure
There are three methods for authoring question banks in the system.

- Question Bank Editor
- Maple T.A. plain-text script files
- LaTeX files that can produce math-intensive questions formatted to Maple T.A. specifications

This document discusses using the Question Bank Editor.

2.2 Question Bank Editor

To navigate to the Question Bank Editor:
- From the Instructor Main Menu, click Question Bank Editor.

Figure 2-B Question Bank Editor

In the Question Bank Editor main window, you can:

- Create a New question bank.
- Upload a question bank (.qu file) from your computer.
- Synchronize (reorder) questions banks to match the order of the parent class.
- Open a question bank from the list of class question bank titles, by clicking the question bank name.
- Resume editing the question bank project you edited most recently.
- Reorganize the displayed list of question banks by clicking the associated drop-down button and selecting placement.
- Delete a question bank from the list.
2.3 Creating a Question Bank

When creating a question bank, the overall process consists of the following.

- Starting a new question bank
- Adding a topic
- Adding questions
- Saving your work by installing your new question bank to the server or by saving a copy to your hard drive.

Starting a New Question Bank

To start a new question bank:
1. From the Question Bank Editor, click New to start writing a new empty question bank.
2. Click Ok. The Question Bank Editor>Main Menu opens.
3. Proceed to the instructions in Adding a Topic.

Adding a Topic

To add a topic to your question bank:
1. In the Question Bank Editor>Main Menu screen, click Add Topic.
2. Enter the new topic name. Click Ok. The system adds the new topic.
3. The left pane displays the new topic name.
Whenever you add a topic, the system collapses any expanded topic, adds the new topic below any pre-existing topics, and expands the new topic. To expand the previously expanded topic, click the triangle to the left of the topic name.

Adding a Question

To create a question:
1. In the left pane of the Question Bank Editor, expand the existing topic. The topic folder opens and displays the contained questions (by name) in the left panel.

   Note: If you have just added the topic, the system expands the new topic automatically.
2. Click **Add a question** to create a new question in a topic. The **Question Bank Editor** > **Add Question** window opens. Begin by selecting a Question Type.

**Figure 2-C** Question Bank Editor> Add Question Screen

**Question Types** Maple T.A. provides the following question types.

- Mathematical & Scientific Free Response Question Types (14 varieties including formula, numeric, and questions that use the Maplesoft™ Maple™ mathematical software to grade and plot student responses)
- Multiple Choice (permuting and non-permuting)
- Multiple Selection (permuting and non-permuting)
- True-or-False (non-permuting)
- Ungraded Essay
- Graded Free Response (or Fill-in-the-blank) - 4 varieties
- Inline
- Key Word or Phrase
- List
- Clickable Image
- Short Phrase
- Matching
• Multipart Questions (consisting of parts that are of any question type; can be nested)
• Questions using a programmable palette of symbols for the entry of student responses
• Questions with applet interaction
• Questions using Web references/objects (including plots)

For examples, see Example Questions on page 13.

**Equation Editor**

The Equation Editor allows you to enter symbolic math in any question type. The Equation Editor is accessed in any question type by first clicking in a text area and then clicking the **Equation Editor** button. Once the Equation Editor screen is displayed, right-click (Control-click, Macintosh) to display the palettes.

**Figure 2-D** Equation Editor Button in Question Bank Editor
Once the Equation Editor screen is displayed, right click to display the palettes.

Figure 2-E Equation Editor

Installing a Question Bank
When working in the Question Bank Editor, the system does not save the changes to the class until you install it. After you install a question bank, it is available for assignment creation.

To install a question bank that has been created or uploaded:
1. Return to the Question Bank Editor>Main Menu, if necessary, by clicking the Main Menu button.
2. Click Install Bank.
3. Enter a question bank name.
4. Click Ok. The system reports "Installation successfully completed".

Note: If you save the question bank with the same name, the system issues the following warning that you are about to overwrite the question bank.
This will replace all the topics and questions in that question bank with your current topics and questions. If you save your question bank under this title, any assignments that you have set up to use the question bank that's currently saved with this title will use the new question bank from now on. However records of
2.4 Example Questions

This document discusses three question types: Multiple Choice, Maple-graded, and Inline. You are guided through a simple multiple choice question, followed by an enhanced version using randomly-determined parameters, and then Maple-graded and Inline questions.

Multiple Choice

The following provides instruction for creating a simple multiple choice question. In addition, navigating, previewing, and enhancing the appearance of a question are discussed. The following procedure assumes you have completed the instructions in Adding a Topic and Adding a Question.

To create a Multiple Choice question:

1. In the Question Bank Editor>Add Question window, select the Multiple Choice question type from the Question Type drop-down list.
2. Enter “Multiple Choice” as a description in the Question Description field.
3. Select the Use HTML for the question text option.
   You can use HTML instead of plain text to write the details of the question and any supporting material (for example, hints, comments, or a worked solution). Use HTML to apply formatting to your text (for example, bold, italics, or a font), or include images, tables, or links to other file resources. For information on uploading files, see Uploading Files on page 54.
4. Click Next. The Question Bank Editor>Add Question>Multiple Choice window opens.
5. In the Text of the question field, enter the following. (Optional. Add the HTML tags to enhance the text.)
   
   \(<p><b><big>Question:</big></b></p>
   
   <p>What is 17 + 9 ?</p>

   Note: An enhanced version of this example is provided in the democlass included with your installation.

6. In the Choices for the answers section, enter 26, 27, and 23 as possible answers, one for each field.
7. Click the radio button beside the 26 to mark this as the correct answer.
8. Click Yes for Change the order of answers. Click No for Allow more than one selection.
9. Click Finish. The Question Bank Editor>Preview Question window opens, displaying the question as it appears to the student.

To test and review your question:
1. In the Question Bank Editor>Preview Question window, select the correct answer (26) and click Grade. The Preview Grade window opens. A Correct icon is displayed along with your answer matching the correct answer. Click Ok to close this window and return to the Preview Question window.
2. Again in the Preview Question window, select an incorrect answer (23) and click Grade. The Preview Grade window opens. An Incorrect icon is displayed along with your answer and the correct answer. Click Ok to close this window and return to the Preview Question window.

In the next example, the Multiple Choice question is edited and enhanced by incorporating randomly-determined parameters.

Multiple Choice Question Using the Equation Editor You can use the Equation Editor with all question types. For example, to create a multiple choice question to determine a square root, use the previous instructions (starting at step 5) with the following additions.

1. In the Text of the question field, enter the following.

What is
2. Click the **Equation Editor** button. The Equation Editor window opens with the phrase "What is" displayed in the **Preview** field.

3. Right-click in the **Equation Editor** field. From the displayed palettes, select a square root symbol. The symbol is displayed in the Equation Editor.

**Figure 2-F**  Equation Editor

4. Replace the “a” in the square root with 144, and click **Update**. The square root of 144 is now displayed in the **Preview** field.

5. Click **OK**. The code from the Equation Editor is displayed as MathML in the **Text of the Question** field.
6. In the Choices for the answers section, enter 12, 14, 72, 13, and 15 as possible answers, one for each field.
7. Click the radio button beside the 12 to mark this as the correct answer.
8. Click Yes for Change the order of answers. Click No for Allow more than one selection.
9. Click Finish. The Question Bank Editor>Preview Question window opens, displaying the question as it appears to the student.
Multiple Choice Question with Randomly-Determined Parameters

The Multiple Choice question is extended by specifying algorithmic variables, hints, solutions, and feedback. The `democlass` provided with your installation contains a similar example.

Specifying algorithmic variables allows you to generate a question that varies each time you view it. Because values in the question are randomly determined for each instantiation, students answer variations of the same question.

Figure 2-H Question Bank Editor with Algorithm Example

To specify algorithmic variables:
Continuing with the Multiple Choice question.
1. In the **Preview Question** window, click **Edit**. The **Add Question** window opens.
   
   Note: This procedure will overwrite the first question and not create a new one.

2. In the **Question Description** field, change the description to “Multiple Choice Enhanced”.

3. In the Algorithm section of this window, click **Add**. The **Edit Algorithm** window opens.

4. Enter the following code in the text box.
   
   ```
   $a=\text{range}(7);
   $b=\text{range}(7);
   $\text{ans}=\text{int}($a + $b);
   $\text{wronga} =\text{int}($\text{ans} - 1);
   $\text{wrongb} =\text{int}($\text{ans} + 2);
   ```

   - The **range(n)** function generates a random integer in the range $1,..., n$ (inclusive). There are $n$ numbers in that range. Hence, it is a selection of one number from a choice of $n$.
   - The **int(x)** function returns the integer part of $x$.
   - $\text{}$ is required to indicate a variable.
   - The question variables are set to $a$ and $b$. These will range from 1 to 7. The answer is set to $\text{ans}$, which is the integer value of $a+b$.
   - As this question is multiple choice, you must generate wrong answers to be displayed alongside the correct answer. For variation, the wrong answer variable $\text{wronga}$ is set to the randomly generated variable $\text{ans}-1$, while $\text{wrongb}$ is set to the randomly generated variable $\text{ans}+2$.
   - All lines end with a semicolon.

5. Click **Save**. The **Add Question** window is displayed.

6. In the **Feedback** section, click **Add**. The **Edit Feedback** window opens.

7. Enter the following text in the feedback text field.
   
   The sum of $a$ and $b$ is $\text{ans}$.

   As the instructor, you can choose to have this information shown to students when they view their graded assignments.

8. Click **Save**. The **Add Question** window is displayed.

9. Click **Next** to open the Multiple Choice window. You must now edit the text of the question and the answer choices to use the variables.

10. In the **Text of the question** field, scroll to the text containing the specific question. Replace
   
   `<p>What is 17 + 9 ?</p>` with `<p>What is $a + b$ ?</p>`
11. In the **Choices for answer** fields, replace the previous answers with the variables $\text{wronga}$, $\text{ans}$, $\text{wrongb}$. Ensure that the $\text{ans}$ variable is selected to be the correct answer.

12. Click **Finish**. The **Preview Question** window opens. Test the question by selecting an answer and clicking **Grade**.

**Maple-Graded Question**

The Maple-graded question type uses the Maple™ computer algebra system to generate algorithmic variables in questions, to render plots, and to evaluate student responses. The Maple-graded question type gives you access to the computational power of Maple. It includes facilities for algebra, calculus, differential equations, discrete mathematics, graphics, numerical computation, and many other areas of mathematics.

You can also use Maple to create questions whose responses require sets, differential equations, unevaluated integrals, groups, and many other types of mathematical data. You can assign partial grades, allowing you to find common errors and reward partial marks.

With the Maple-graded question type, you also have access to the plotting capabilities of Maple. You can use Maple to plot a student response (or a function derived from a student response, for example, the definite integral of the student response) for a Maple-graded question type or display a plot for any question type.

You must adhere to these guidelines when using Maple code for Maple-graded questions.

- A Maple-graded question must use valid Maple code to evaluate the answer. Complete each line of code with a semicolon. For information on Maple code, refer to your Maple system documentation.
- The student response code must evaluate to a Boolean value or a floating-point number between 0 and 1.
- Use the long form name for all package commands, for example, `VectorCalculus[ArcLength]`.

**Note:** Maplet applications are not directly accessible in Maple T.A.
EDU Campus

Figure 2-I  Question Bank Editor, Maple-Graded Question

![Question Bank Editor, Maple-Graded Question](image)
To create a Maple-graded question:

1. Click Add a question to create a new question in a topic.
   The Question Bank Editor > Add Question window opens.
2. From the Question Type drop-down menu, select Maple-graded.
3. In the Question Description field, enter “Differentiation”.
4. Click Next.
5. Enter the text of the question field:
   Differentiate sin(x) * x

6. Enter Maple code that evaluates to the correct answer:
   diff(sin(x)*x, x);

7. The following Maple code to grade the student response is provided automatically:
   evalb(($RESPONSE) - ($ANSWER)=0);

   $RESPONSE is a system variable that corresponds to the response the student
   entered when completing the question and $ANSWER refers to the correct
   answer you entered in step 6.

   **Note:** By default, the Maple-graded question type accepts Formula
   expressions. In Maple-graded Formula question types, students can enter a math formula,
   that is, an expression constructed of numbers, variable names, and the standard
   arithmetic expressions and functions. The student must not use Maple commands
   in the response. The instructor must write code such that the student does not
   have to use a trailing semicolon in the response. For details, refer to the Maple
   T.A. Help system.

8. Click Finish.
9. Enter the correct answer, cos(x)*x+sin(x), and click Grade.

**Plotting the Student’s Response** Using the Maple-graded question type,
   you can generate a plot of the student’s response. This allows students to
   visually check their response before proceeding.

To plot the student’s response:

1. Click Edit, and then Next. The Question Bank Editor > Edit
   Question > Maple Graded window opens.
2. Scroll to the bottom of the question. In the Plotting field, enter:
   plot([$RESPONSE, sin(x)*x], x= -10..10);

   $RESPONSE is a system variable that corresponds to the student’s response.

3. Click Finish.
4. Test the question by entering a response and selecting the Plot link. The plot is displayed in a separate window.

**Inserting a Maple Plot in Question Text**  You can also insert a Maple generated plot in the text or answer of any type of question.

**To insert a Maple plot as an algorithmic variable:**

1. Click **Edit** to edit the current question.
2. Click the **Add** button in the Algorithm section.

    
    ![Algorithm Section](image)

3. Enter the following:

   \$plot1=plotmaple("plot(sin(x)*x, x=-10..10)"

4. Click **Save**.

5. Use the algorithmic variable \$plot1 to display the Maple plot. It can be used anywhere algorithmic variables can be used and in all question types.

   **Note:** You can add plot options, such as width and height.

Before leaving the Question Bank Editor, you must install your work to the Maple T.A. server. For instructions, see *Installing a Question Bank* on page 12.

**Apply Partial Grading to Maple-graded Questions**  You can modify Maple-graded questions to allow grading between 0.0 and 1.0 for part marks.

The following is a simple application of partial marks. In solving \(3x+6=12\) for \(x\), students may add 6 to 12 instead of subtracting it. If they made this error, but divided by 3 properly, they would get a result of 6. In this case, the instructor can give them half marks by using the grading code shown below.

<table>
<thead>
<tr>
<th>Text for the question</th>
<th>Solve for (x) in the following equation: (3x+6=12)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maple code that evaluates to the correct answer</td>
<td><code>solve(3*x+6=12,x);</code></td>
</tr>
<tr>
<td>Maple code to grade the student response</td>
<td><code>if ($RESPONSE=6) then 0.5 else evalb($RESPONSE- ($ANSWER)=0) end if;</code></td>
</tr>
</tbody>
</table>
Inline Questions

Inline questions are a flexible and extensible form of free response questions that can include multiple response cells. They are similar to multipart questions in that they provide a shell structure in which to embed other questions. Inline questions are constructed using the Visual Editor.

Visual Editor The Visual Editor is an authoring environment as familiar as your word processor. Using the Visual Editor you enter question text and the correct answers, wherever they should appear. You can apply character formats such boldface, italic, or underlining using toolbar buttons, menu commands, or familiar control key combinations. When you are satisfied with the appearance of the question, you define answer regions or Student Response Objects (SROs), and then apply grading and other behaviors in the SRO Properties panel at the bottom of the Editor window.

The Visual Editor contains two views of your question: a WYSIWYG editor view (Editor tab), and an HTML editor view (HTML tab) for editing the HTML source code of the question. Your questions can contain any standard HTML elements, including character formatting, tables, embedded images, and media objects. In addition, you can insert algorithmic variables and inline math expressions as required.

At the bottom of the Visual Editor window is the SRO Properties Panel, which allows you to define the SRO mode (question type), weighting, grading behaviors, display behaviors, and correct answers. You can define additional behaviors according to the individual question mode you select.

At the top of the Visual Editor window is the command menu and toolbar, including the unique Make SRO button and menu option that you use to activate the Student Response Objects (SROs) you define in your question.

As the Inline questions form a shell structure in which to embed questions, they support the following question types:

- Formula Question Types: Formula, Formula Mod C, Restricted Formula, Equation, Vector of Formulas, and Chemical Equation
- List Questions, including text or menu input styles, exact or relaxed graders, multiple correct or incorrect responses can be specified, partial credit can be defined for each response
- Maple-graded Question Types: Formula and Maple Syntax
- Multiple Choice, Non-permuting Multiple Choice (displayed horizontally or vertically)
- Multiple Selection, Non-permuting Multiple Selection (displayed horizontally or vertically)
Numeric Question Types: With and without required unit dimensions

To create an Inline question:
1. In the Question Bank Editor>Add Question window, select the Inline question type from the Question Type drop-down list.
2. Click Next. The Question Bank Editor opens the Visual Editor.

Overview of Authoring Inline Questions
Before attempting an Inline question, consider the following process.
1. Enter your questions in the Visual Editor.
2. Highlight the word or words that define the answer to your question.
3. Select Edit>Make SRO from the main menu (or click the Insert SRO button) to activate the selected answers.
4. Define the SRO properties in the panel at the bottom of the editor window. You must define the behaviors for each response cell.
   - Select the question type
   - Assign weighting
   - Configure the grader to be applied
   - Define multiple correct, incorrect, or partially correct responses
   - Set question presentation styles
5. Repeat this process for other SROs within your question item.

Inline Examples: List and Formula Questions

To create an Inline List question:
1. In the Question Bank Editor>Add Question screen, select the Inline question type from the Question Type drop-down list.
2. Enter “Inline List” as a description in the Question Description field.
3. Click Next. The Question Bank Editor opens with the Visual Editor active.
4. In the blank text area, enter the following question.
   Who introduced the Arabic number system to Europe?
5. Enter the correct answer “Leonardo Fibonacci” directly beside the question, and select the text.
6. From the Edit menu, select Insert SRO to activate the selected text as the point for the response text cell to be inserted. The answer text is displayed in red font and yellow highlighting.
7. The SRO Properties panel at the bottom of the Visual Editor is now displayed. In the column beside Question Type, click unset. A drop-down list of question types is displayed. Select List Mode.

8. Set Matching type to Exact text match (default value) to apply strict grading, case-sensitive, literal string-matching as your grading mode. To invoke a less stringent grader that ignores case sensitivity and punctuation, select Ignore case text match. The List Mode also provides a regular expression-matching grader, useful for customization of the Question Bank Editor.

9. The default Display type is Text field, which presents students with a graded free-response cell “blank.” For this example, select Drop-down menu to present students with a drop-down menu. Select the adjacent Permute list check box.

10. Answer 1 is automatically encapsulated from the text you selected, and defined by default as the answer to the question. Confirm the correct answer. Note that the right column holds a credit definition of "1" for this item.

11. Add additional answer choices by completing the Next item field (repeatedly if required). The system automatically numbers your choices. For this List example, enter the following names, “Niels Henrik Abel” “Jean Baptiste Fourier” and “Jacques Salomon Hadamard”.

   - As you add expected answers the system assigns them a credit value of “0” in the right column. You can click this field and create additional answers
that will be graded as fully correct ("1") or partially correct answers (with any value between 0 and 1 assigned).

12. Click the **Finish** button at the top of the **Visual Editor**. The Question Bank Editor displays the question as it is viewed by students.

   If you choose to edit this question, click **Edit**, and then **Next** to return to the **Visual Editor**. Click the highlighted answer in the text field to activate the SRO Properties panel at the bottom of the **Visual Editor**.

**To create an Inline Numeric question:**

1. In the **Question Bank Editor>Add Question** screen, select the **Inline** question type from the **Question Type** drop-down list.
2. Enter "Inline Numeric" as a description in the **Question Description** field.
3. Click **Next**. The **Question Bank Editor** opens with the **Visual Editor** active.
4. In the blank text area, enter the following question.

   Round 2.76789m to three significant digits.

5. Enter the correct answer "2.77" directly beside the question and select the number.
6. From the **Edit** menu, select **Insert SRO** to activate the selected text (in this case, the number 2.77) as the point for the response text cell to be inserted. The answer is displayed in red font and yellow highlighting.
7. The SRO Properties panel at the bottom of the Visual Editor is now displayed. In the column beside Question Type, click **unset**. A drop-down list of question types is displayed. Select **Numeric**.
8. The system encapsulates the selected text as the answer definition in the **Number part** field. Confirm the correct answer.
9. Click the blank field next to the **Units part** column and enter a required unit dimension for the correct answer (in this case, m for meters.) If you do not enter a required unit dimension, the system displays only a single response cell that accepts numbers only for student answers. If you do enter a required unit dimension, students are presented with two cells: one for the number part and one for the unit dimension.
10. To set the margin of error, click the **Required with...** field, which by default is set to **absolute accuracy**. You can specify absolute precision (student answers must match the defined answer exactly), or a significant figure precision for an exact answer match.
11. To set tolerance, use one of the three modes presented. Click **Edit** (in the **Number format** row to specify acceptable number formats). The **Number Format** dialog opens.
12. Click **Finish** to save the question.
Symbolic Math in Inline Questions  You can enter symbolic math in any question type. In Inline questions, you must click the Sigma symbol in the toolbar. The Math Input dialog opens. Right-click (Control-click, Macintosh) to access the palettes.

Figure 2-J  Enter Symbolic Math in Inline Questions

Exporting and Saving Files  You can save files you create in the Visual Editor to your computer. To upload/open or download/save files using the Visual Editor, you must first configure your system settings for the Visual Editor Java applet. For security reasons, Java applets are not allowed to read or write files on your computer unless you explicitly grant them permission.

To grant permissions to the Inline Question Editor applet:
1. Download the permission installer when the permissions.jar package is offered.
2. Save the file to your Desktop.
3. Run the permission installer. Double-click the permissions.jar file to execute it.
4. If you are using a command prompt, you can execute it with the command java -jar permissions.jar
5. A window opens. Enter the address of your class and follow the on-screen instructions through the installation process.
6. You must restart your browser to invoke the permissions.
To save a file created in the Visual Editor:
1. Select File > Save from the main menu in the Visual Editor. (Alternatively, click the Save button on the toolbar.)
2. Select a save location for the file on your PC.

Your file contains all the object definitions and SRO properties and can be uploaded and edited in the Visual Editor during another session.

2.5 Editing an Installed Question Bank

As the need arises, you can edit your installed question banks to reflect new course work.

To open an installed question bank:
1. From the Instructor Main Menu, click Question Bank Editor.
2. From the Question Bank list, click the name of the question bank to open for editing.
3. Proceed with editing as required.
4. When you have completed editing, reinstall the question bank. In the Main Menu click Install Bank.

When reinstalling an updated version of a question bank, you can:

- Replace the previous version by using the same name. New assignments that reference the previous version are automatically edited to use the updated questions from the new version.
- Keep both versions by using a new name. Assignments that reference the previous version continue to use the previous versions of the questions. To use the new questions, create new assignments or edit old assignments to reference the updated question bank.

2.6 Backing up a Question Bank

Downloading a Question Bank to Your Hard Drive

The process in this document outlined the creating, editing, and installing of a question bank. While editing a question bank, it is recommended that you
install the question bank or back up your work by downloading to your hard drive regularly.

To back up a question bank by downloading to your hard drive:

1. Return to the Question Bank Editor>Main Menu, if necessary, by clicking the Main Menu button.
2. Click Download. The File Download dialog opens.
3. The question bank is listed with the temporary name testbank.qu. Click Save. In the Save As dialog, navigate to a suitable directory and enter a question bank name. Click Save. The file is saved with the .qu extension.
4. A message is displayed indicating the download is complete. Click Close.

Opening a Question Bank Downloaded to Your Hard Drive

You can upload the saved question bank file (plain-text script file), and then continue editing or install it in your class.

To open a question bank file that was downloaded to your hard drive:

1. From the Instructor Main Menu, click Question Bank Editor.
2. Click Upload.
3. To locate your file, click Browse.
4. Navigate to the source file on your hard drive and click Open. The path and filename are displayed in the Question bank field of the Upload File window.
5. To upload the question bank, click Load. The Question Bank Editor>Main Menu window opens with the topics and questions of the uploaded question bank in the left panel.

Notes: To upload a file from the Question Bank Editor>Main Menu. Click Upload and follow the on-screen instructions.
You can also merge the contents of a question bank file into another question bank file by uploading a question bank while another one is open.

When you upload a question bank file into the system, it performs a set of validation routines to ensure that the questions function. Occasionally, you may encounter an error with a variable name or definition upon uploading. The following is a summary of the system's analysis of variables upon initial loading of a question bank file.

- For variables displayed within HTML text, for example, in a question statement or feedback, a problematic variable does not produce a data value generated from its definition. Instead its variable name is displayed, highlighted in red.
• For variables appearing in non-displayed field parameters, for example, the answer to a question, the variables $\text{ANSWER}$ and $\text{RESPONSE}$ default to 0. All others have the variable name passed.

6. Install the question bank. In the Main Menu click Install Bank.
3 Assignments

3.1 Overview

Assignments are created by selecting questions from question banks. The assignments you create can be organized such that Maple T.A. reorders questions, generates new questions (based on a range of variables you define), or displays a subset of questions. As such, each student viewing your assignment can potentially complete a unique set of questions.

Figure 3-A The Relationship between Question Banks and Assignments

The Assignment Editor allows you to create new assignments, edit the content, properties, and appearance of existing assignments, delete assignments, and change the order of existing assignments.
Assignment Editor Main Menu

In the Assignment Editor main window, you can:

- Click **New** to create a new assignment.
- Click **Synchronize** to reorder the assignment list to match the order in the parent class.
- Reorganize the order of displayed assignments using the drop-down button.
- Open assignments by clicking the assignment name link.

To activate other options, hover your mouse over the assignment name. Six option buttons are displayed.

- Edit assignments by clicking **edit**.
- Copy assignments by clicking **copy**.
- Delete assignments by clicking **delete**.
- Hide assignments from student view in the **Class Home Page** by clicking **hide**.
- Print assignments. Clicking the **print** link displays the print preview of the assignment. You then have the option to print the assignment or click **Back** to return to the Assignment Editor.
- View a summary of the assignment by clicking **summary**.

Figure 3-B Assignment Editor

The Assignment Editor main menu lists assignments created for your class. These assignments may be populated with a series of assignments based on testing materials, or other shared question banks. If not, you initially see a blank list here. For more information on shared classes, see Shared Classes on page 55.
Warnings and Locking Mechanism

When an assignment is opened for edit, the system checks and warns the instructor whether the assignment has associated student records in the Gradebook or is currently in use by a student.

**Note:** The number of students currently using the assignment is displayed in the Active field of the Assignment Editor main menu.

- If the assignment is currently in use, the assignment is locked so that an instructor cannot edit it.
- If the assignment is not currently active, the assignment is locked for editing so that new active tests cannot be started during the editing process. Students who try to start the assignment while it is locked are notified with a warning message.

### 3.2 Creating Assignments

The Assignment Editor organizes assignment creation into a four step process.

- Naming your assignment
- Selecting questions
- Establishing rules and policies
- Reviewing, finishing, and publishing assignments to your class

**To start a new assignment:**

1. From the Assignment Editor screen, click New to begin a new assignment. The Assignment Editor displays four tabs: Choose Name, Select Questions, Set Policies, and Review & Finish.
2. Proceed to the instructions in Naming Assignments.
3.3 Naming Assignments

The assignment name is displayed to students on the Class Home Page.

To name your assignment:
1. In the Choose Name tab, enter a name for your assignment in the Choose A Name For Your Assignment field.
2. Optional. Click the Advanced button. Add assignment-level page headers and text for the results page in the appropriate fields.
3. Proceed to the instructions in Selecting Questions.

3.4 Selecting Questions

The Select Questions tab of the Assignment Editor allows you to select questions (individually or as a group) from question banks, assign question weighting, scramble the sequence of delivery, and merge individual questions to form specific question groups.

To select questions from question banks:
1. In the Assignment Editor, click the Select Questions tab.
2. From the Question Bank drop-down list, select a source question bank.
3. If required, expand the topic lists and select the questions you want from the list on the left using the check boxes. Click the Add button after selecting a question or complete the selection process and click the Add As Items button. In either case, individual questions are added to your assignment.
4. Optional. To add a selection of items as a group, select questions using the check boxes. Click Add As Group to include them as a pool of questions within your assignment.
5. Optional.
   • Change the default question weighting (one point per question) to match your requirements.
   • Select Scramble questions to randomly order the questions when assignments are created.
   • Reorder questions within your assignment by using the drop-down lists.
   • Merge individual selected questions to form new question groups in your assignment.
6. Proceed to the instructions in Setting Policies.
Individual Versus Grouped Questions

Individual Questions  If you add selected questions to your assignment as individual questions, each one is included in every version of the assignment served to a student, and you control question weighting individually.

Question Groups  Adding questions in question groups provides you with the added option of selecting a group of questions and having the system select from the questions at random, according to criteria you specify (for example, choosing three of seven questions from the group each time a new assignment is created for a student). You set a single point value that is applied to every question in the group.

3.5 Setting Policies

In the Set Policies tab of the Assignment Editor window, you can:

- Select the type of assignment
- Decide when to make it available to your class
- Set feedback options for the assignment
- Establish other grading policies
Assignment Types

Assessment Type Assignments  You can create graded assessments (Homework or Quiz and Proctored Exam), ungraded practice tests (Anonymous Practice), or assignments with set criteria (Mastery and Study Session). You can configure the number of questions on a page, create test instruction sheets and headers, and set policies for restricted access, repeated attempts, and other options.

Students answer questions one page at a time, and the system records their responses between pages. Jumping from question to question within an assignment is allowed until students complete all questions (or choose to
ignore the warnings to do so) and submit their responses for automatic grading.

**Homework or Quiz** assignments have the following format.

- Students are presented with an assignment consisting of any number of instructor-selected questions.
- Questions are delivered either in an instructor-specified or random sequence.
- Student responses during sessions are recorded (but not graded) after every question, so assignment sessions can be interrupted and continued upon next login.
- Students must be registered in the class and logged in to begin a Homework or Quiz assignment.
- By default, Homework or Quiz assignments can be attempted multiple times for credit. To limit the number of attempts a student can make on a particular assignment, use Assignment Properties of the Set Policies tab in the Assignment Editor.
- Results for every attempt at a Homework or Quiz assignment are recorded in the Gradebook for the class.

**Proctored Exams** are similar to Homework or Quiz assignments, but with an additional security measure to confirm the identity of the student taking the test. All Proctored Exams require a proctor to authorize students submitting their test for grading. You can require proctor authorization to validate student identity and grant assignment access at the start of a proctored exam. Students must be registered in your class. They are required to provide their student login and password to access assignments in addition to proctor authorization.

There are two types of proctors: **Global** and **Local**.

- Global proctors are defined by the System Administrator and can give authorization for any class.
- Local proctors are defined by the Instructor and can only give authorization for a particular class.

Proctors can give authorization directly, at the student's computer, or remotely through the **Proctor Tools Main Menu**. In both cases, the proctor must sign in by giving a login name and password. To give authorization remotely, the proctor must login using the **Proctor Login** option on the **Class Home Page**.

To set up proctors, you must use **System Tools**. For an overview of **System Tools** see Chapter 5: System Tools on page 53. For details, refer to the Adding a Proctor help page in the Maple T.A. help system.
Anonymous Practice assignments are similar to Homework or Quiz assignments; however, students are not required to log in. Any number of questions can be included, and the assignment is delivered in an instructor-specified sequence (or scrambled). Graded assignment reports are produced upon conclusion of the assignment, but results are not recorded in the Gradebook. Students can view their results at the end of the session; no permanent record is maintained. Results can be printed, but are only available for as long as a student displays them.

Study Session and Mastery These assignments usually draw from a large pool of assignment material (often algorithmically generated to produce limitless question permutations). The instructor chooses the questions to include and sets criteria for mastery assignments.

Assignments are delivered one-question-at-a-time, and the student submits each question for grading individually and immediately, instead of having the entire test graded at the end.

Mastery and Study Session assignment types emphasize the following pedagogical approaches.

- For Mastery assignments, instructors create carefully structured collections of questions grouped by learning objectives. Mastery assignments require a login and password, and results are recorded in the Gradebook. The default delivery is in sequential order.
- For Study Sessions, students control the study process by practicing question after question. You can provide hints and full solutions for questions to students while they work. Results are displayed one question at a time and are not recorded in the Gradebook. Students are not required to log in.

For assignment attributes, see the following table.
3.5 Setting Policies

Setting the Assignment Type

To set the assignment type:

1. Select one of the options in the Type of Assignment group box in the Set Policies tab of the Assignment Editor. Homework or Quiz is the system default assignment type.

2. For any assignment type, you can click the Advanced button to set prerequisite conditions.

If you select Mastery assignment type, by default, questions are organized in sequential order. To specify additional criteria for your assignment, click the Edit mastery policies link. For details, refer to the Set Mastery Policies help page in the Maple T.A. Help system.

Assignment Visibility

1. Optional. By default, the Visible check box is selected. Clear this check box to temporarily exclude the assignment from the list of assignments displayed to students on your Class Home Page. Or, in the Assignment Editor main menu, click the hide option available on mouse rollover of the assignment name. See Assignment Editor Main Menu on page 32.


Assignment Feedback

You can specify the type and timing of assignment feedback displayed to students.

Note: You can allow access to question hints (if they exist) in any assignment type. If you choose to display hints and comments but your source questions

Table 1: Assignment Types

<table>
<thead>
<tr>
<th>Assignment Type</th>
<th>Graded</th>
<th>Recorded in Gradebook</th>
<th>Student Login Required</th>
<th>Student Password Required</th>
<th>Student Registered in Class</th>
<th>Hints Available</th>
<th>Solutions Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous Practice</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Homework/Quiz</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Mastery</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Proctored Exams</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Study Session</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
(from the Question Bank) do not include them, the system ignores the display settings.

**To set assignment feedback:**
- To display hints during an assignment, select the **Show hints** check box.
- To display the final grade after the assignment is graded, select the **Show the final grade** check box.
- You can show feedback **During the assignment**, for example, displaying the correct answer or comment for each question. In the drop-down lists of the **Feedback** group box, select from **Always, If correct, If incorrect, or Never** condition options for displaying the correct answer or question comment.
- You can show feedback **After the assignment is graded**, for example, displaying the correct answer or comment for each question. In the drop-down lists of the **Feedback** group box, select from **Always, If correct, If incorrect, or Never** condition options for displaying the correct answer or question comment.
- The program can send you an email whenever a student completes the assignment in Homework and Proctored Exam mode, giving the name of the student and the result. To receive email notification, select the **Send email reports to** check box and enter your email address.

**Note:** To use this feature, your system administrator must have an SMTP server configured.

**Assignment Properties**

In the **Assignment Properties** dialog, you can set:

- Passing score
- Time limit
- Number of questions on a page
- Maximum number of times an assignment may be taken

**Setting a Passing Score**  If you select the Practice, Homework, or Proctored Exam assignment types, you can set a passing score for the assignment. If you set a score, the system assesses each assignment attempt as either Pass or Fail, and records this information in the Gradebook automatically. The field shows the total available score for the assignment (for example, out of 10), which varies according to the composition of your assignment.

**Setting a Time Limit**  If you select Homework or Proctored Exam assignment types, you can set a time limit for the test. If you set a limit, the program shows the student the time remaining during the course of the test. If the time limit expires during the test, the system informs the student, and does not allow the student to enter responses to any more questions.
3.5 Setting Policies

**Note**: The timer does not stop until the student runs out of time or clicks **Grade**. The timer will continue to run even if the student has clicked **Quit and Save**.

**Setting the Number of Questions per Page**  
By default, the program displays one question per page when presenting an assignment to students. You can use this option to deliver more than one question per page. If you have used question annotations and set the annotations to display at the top or the bottom of the page in which the question is loaded, your annotations appear as a page-level header or footer (rather than immediately before or after the question).

**Note**: Mastery and Study Session assignments automatically serve one question at a time. This is part of their instructional design and this setting cannot be changed for these assignment types.

**Tip**: If you are concerned about a student's ability to assess complicated questions over a slower online connection, it is recommended that you accept the default setting for questions per page (which is one-at-a-time). Loading one question at a time usually allows a student to move through the assignment effectively, but also saves each question response as it is completed.

**Setting the Maximum Number of Attempts**  
For Homework and Proctored Exam assignments, you can set the maximum number of times a student can take an assignment. If the student attempts more than the maximum amount, a message is displayed indicating the restriction. If the assignment is a Proctored Exam, the student can click the **Exception** button displayed in the restriction message screen. A proctor can then provide authorization.

**Scheduling Assignments**

Using the calendar function in the **Scheduling** dialog, you can set **Start** and **End** times for each assignment. These times govern the availability of the assignment to students accessing your Class Home Page. Scheduled times refer to your server clock and system's time zone set by your System Administrator.

Before and after the indicated availability window, the assignment is still displayed in the assignment list viewable by students on your Class Home Page, but it cannot be selected. Note that unavailable assignments appear in the list of assignments on the **Assignment Editor Main Menu** page. Additionally, unavailable assignments will appear in the student's past results page, if the student completed them.
3.6 Reviewing and Saving Assignments

In the **Review & Finish** tab of the **Assignment Editor**, you can review assignment summary information, including:

- Assignment Type
- Questions Selected
- Scheduled Availability
- Rules and policies you established

**To change settings in your assignment:**
1. In the **Review & Finish** tab, click the highlighted link in the category to be changed.
2. A prompt appears asking whether to return to the tab where the option is set. Click **OK**. The appropriate **Assignment Editor** tab opens.
3. Make changes and return to the **Review & Finish** tab.

**Finishing an Assignment**

**To accept and publish the assignment you have created or modified:**
- Click **Finish** in the **Review & Finish** tab. You are returned to the **Assignment Editor** list of assignments for your class, where your new assignment is displayed in the list of all class assignments.

**Assignment Status**

Consider the following information regarding your assignment status:

- If you have scheduled the assignment for immediate availability, your new assignment is available for students in the **Class Home Page**.
- The system does not save partially completed assignments until you click **Finish** in the **Review & Finish** tab of the **Assignment Editor**. If you begin to create an assignment and then abandon it without clicking **Finish**, your additions and changes are lost. If you need to leave the **Assignment Editor** without finishing the assignment, it is recommended that you mark the assignment as hidden so that students cannot access it. Hide assignments from student view in the **Class Home Page** by clicking **hide** in the **Assignment Editor Main Menu**.
- If the server shuts down before you click the **Finish** button, your editing changes will be lost. When the server restarts, it uses the last saved version of your assignment data. To reduce the risk of this during long assignment editing sessions, it is recommended that you periodically click...
the Finish button, then select your assignment from the main Assignment Editor list of assignments to start a new editing session.

3.7 Special Cases

Deleting Assignments
You can select and delete assignments in the main Assignment Editor window. If there are grades associated with an assignment, and you rename or delete the assignment, a copy is made. Also, results continue to be available through individual student records. To learn more about the Gradebook, see Chapter 4: Gradebook on page 45.

Shared Assignments: Saving Your Changes
The following information refers to shared assignments. You may want to return to this section after reading Shared Classes on page 55.

When you complete changes (by clicking Finish in the Review & Finish tab) in a shared assignment and change the Assignment Name, your copy of the assignment automatically appears in the Assignment List of the Assignment Editor Main Menu.

Your assignment appears under its new name at the top of the Assignment List. Note that the original assignment, inherited from the shared or template class, also appears in the list.

If you do not want the original assignment to appear, remove it from view.

- In the Assignment Editor main menu, click the hide option available on mouse rollover of the assignment name.
4 Gradebook

4.1 Overview

Maple T.A. automatically stores the session scores in the Gradebook for assignments requiring students to login. The Gradebook stores information for each student, such as the assignment start time, the time spent on the assignment, and the individual assignment question performance.

The Gradebook allows you to:

- View, analyze, and report scores and statistics for students, assignments, and question items
- Review and edit student results for specific graded sessions
- Create reports organized by student, assignment, or by question item
- Export grades to comma-delimited or tab-delimited (.txt) files
- Complete administrative tasks, such as changing passwords, managing rosters, and sending messages to students

To access the Gradebook:

- From the Instructor Main Menu, click Gradebook.

4.2 Gradebook Views

The Gradebook provides three views of assignment data: by student, by assignment, and by assignment item or question. These views correspond to the first three tabs in the Gradebook. (For information on the Administration tab, see Administration on page 50.)
To view a list of students and their grades, click the Student Statistics tab.
To view summary statistics for each assignment, click the Assignment Statistics tab.
To view summary statistics for each question on an assignment, click the Item Statistics tab.

Generating Reports
You can change assignment weighting, grades, or add comments from within a generated report.

To generate a report in the Gradebook:
1. In the Student, Assignment, or Item Statistics tab, select the assignment(s) to include in the report.
2. Select the data to include in the report from the Show Results, Date Range, Display, and Grade Style group boxes.
3. Select Printer-Friendly Table to display the report in a separate window. Otherwise, the report displays below the Get Report button.
4. Select Download this table as: to obtain a comma, or tab file of the data.
5. Click Get Report.

4.3 Student Statistics
On the Gradebook Student Statistics tab, you can select from the following options to build reports.

- Assignment(s) - To specify assignments to include. (Use CTRL to select more than one assignment.)
- Show Results - To display results, for example, best or most recent.
- Date Range - To specify date range. Assignments completed within that date range will be included in the report.
- Display - To display date and time the assignment was started, the time required to complete, and the Student ID.
- Grade Style - To indicate presentation style for the grade.
From the generated report, you can view a student record report or change the weighting for assignments.

**Assignment Weighting**

After you generate your assignment grade report from contents of the Student Statistics tab, you can set weighting for each assignment with respect to the cumulative grade for the class. Click %Weight in the report. The Set Weightings window opens.

**Changing Grades**

From the resulting report of Student Statistics, you can change a student’s grade. You may change a student’s grade for several reasons:

- The system does not automatically grade essay questions, so you must enter a grade for any essay questions included in your assignment.
- You might choose to raise a student’s grade based on effort, improvement, or other subjective measures.
You might choose to apply a curve, based on the performance of the entire class.

**Figure 4-B** Student Record

To change a student grade:
1. In the resulting report, click the student name. The student record opens as shown in Figure 4-B.
2. Click the assignment name. The assignment results are displayed.
3. Edit the grade in the **Change grade** field on the right-hand side of the screen, and click **Change**.
4. Optional. Add comments. Students see these comments when they review their performance on the test. You can add personalized comments to help individual students understand their scores and master the material.
5. Click **Close** to close the student record.
6. Click **Get Report** to regenerate the statistical information.

### 4.4 Assignment Statistics

In the **Assignment Statistics** tab, you can select from the following options to build a report.

- **Assignment(s)** - To include in your report (use **CTRL** to select more than one assignment).
- **Date Ranges** - To specify date range. Assignments completed within that date range will be included in the report.
4.5 Item Statistics

The system collects statistical data on the questions used in your assignments. It can produce various statistical analyses based on item usage and student performance automatically.

On the Item Statistics tab, select from the following options to build a report.

- **Assignment(s)** - To specify items from particular assignments (use **CTRL** to select more than one assignment).
- **Date Range** - To specify date range. Assignments completed within that date range will be included in the report.
- **Printer-Friendly** - To display the report in a separate window.

![Assignment Statistics](image-url)
The following is a sample report covering a single assignment.

4.6 Administration

The Gradebook Administration tab displays a list of all students registered in the course, including their names and logins. You can use this to:

- Edit student information for individual students.
- Upload a class roster using the Upload Roster option. For details, see the following section.
4.7 Class Roster

Before the Gradebook can begin tracking student performance, it must have a student roster. You can create a roster by:

- Uploading a roster. See Uploading a Class Roster.
- Allowing students to register themselves for your course. See Student Registration on page 52.

Uploading a Class Roster

You can upload a class roster using the Upload Roster option on the Administration tab. The system uploads a text file (for example, *.txt and *.rst) that has one line for each student and has the following format:

- First Name must be at least one alphabetical character.
- Middle Initial must be no more than one alphabetical character.
- Last Name must be at least one alphabetical character.
- Student ID must be at least five alphanumeric characters
- Login, password, and email are optional, but if a login is provided for a student, a password must also be provided.
• If no login is provided the system generates a login and password, which is displayed on the next page. You must print this page. If it is not printed, the automatically generated login and passwords will be lost.
• The fields can be delimited by space, tab, or comma characters.
• If you have a null required field, for example, the student did not provide a middle initial, use two consecutive delimiters.

**To upload a class roster:**

**Important:** Create your class roster as a text file and save it.

1. In the Gradebook, click the Administration tab.
2. Click **Upload Roster**.
3. Select your **File Type** based on the type of delimited text file or spreadsheet.
4. To locate your class roster, click **Browse**. Navigate to the file.
5. Click **Ok**. A screen listing the students' names, logins, and passwords is displayed.
6. Click **Ok**. You return to the Administration tab.

**Student Registration**

Students can register for your class using the **Register as a student in this class** link in the Class Home Page. They must complete the form on the **Student Registration** screen. You can lock access to this form of registration by using the **System Tools**. For more information on managing your system, see Chapter 5: System Tools on page 53.
5 System Tools

5.1 Overview

The System Tools facility enables you to manage your class and exchange course material between your class and others with Maple T.A. You can perform the following tasks.

- Register and manage proctors for your course
- Edit your instructor profile
- Change your class password
- Lock or unlock access to student registration for your class
- Share your assignments and question banks with other instructors
- Work with files on your class Web site
- Create and deploy course modules

In this chapter, the following topics are covered.

- Uploading files to your class Web site
- Shared classes
- Course modules
To access System Tools:
- From the Instructor Main Menu, click System Tools.

Figure 5-A System Tools

5.2 Uploading Files

In conjunction with your Class Home Page, your class also has a Web site folder on the system that you can use to store images and other resource material used in your question banks. The Website Editor provides a list of the Web site content and gives you options for uploading, organizing, and deleting files.

To manage files on your class Web site:
- From the System Tools main menu, select Website Editor.

You can upload multiple resource files to your class Web site if you package them in a compressed zip file first. The Zip Archive option is useful if you have many files to upload.

To upload a file:
1. Click the icon next to the instruction upload files(s) to this point...
The Website Editor/Upload Files screen is displayed.
2. Click Browse to locate and select the file.
3. Click the Single File or Zip Archive radio button. The system uploads the file directly to your class Web site, with the name you specify. (The default name is the name of the file on your computer.) In the case of a zip file, the
5.3 Shared Classes

You can share your question banks, resources, and assignments with other instructors.

- Class sharing is an ideal way to manage multiple class sections of a large course using common question banks and assignments, ranging from practice sessions to exams.
- Shared classes can also contain unique question banks and assignments that are not part of the parent class.

When you share a class, you create a single parent class whose question banks and assignments are cloned. The question banks and assignments are inherited by each child class instance created when registering a copy of the parent.

Question banks and assignments inherited from a parent class are always identified in lists by the shared class icon, which appears beside the assignments and question banks.

To access the Share Class window:
- From the System Tools menu, select Share Class.

Creating a Shared Class

To share the contents of your class with other instructors:
1. From the Instructor Main Menu, select System Tools.
2. Click the Share Class option. The System Utilities Share Class window opens.
3. To share your class, click the Shared radio button.
4. Enter a **Registration Code** and click **OK**.
5. Click **OK** to save your changes.

To enable others to create a copy of your class, including your question banks and assignments, simply distribute your Registration Code along with your class home page URL.

In your **Instructor Login** dialog, a **Register for this class link** appears, enabling others to register a copy of this class.

**To remove class sharing:**
1. From the **Instructor Main Menu**, select **System Tools**.
2. Click the **Share Class** option. The **System Utilities Share Class** window opens.
3. Click the **Not Shared** radio button.
4. Click **OK** to save your changes.

**Shared Class Content Updates**

In general, changes to question banks or assignments in the parent class automatically update the copies of the question banks or assignments in your child classes. However, if you edit and then save your copies of the inherited materials using their original names, you do not receive updates.

The following applies to changes you make to inherited question banks, whether you make changes to them individually using the **Question Bank Editor** or if you use **Course Modules** to make global changes that affect inherited question banks. (Course Modules are described in the next section.)

You break the link to the parent class version of the question bank, if you:

- Edit a parent question bank and then **Install** it using the original name as the parent class.
- Install a course module that has a new version of a question bank with the same name as a question bank in the parent class.

To refresh the content of your class to match that in the parent class or to restore the link to the parent class version of the content, you must do **one** of the following:

- Save your new, edited question bank under a different name and then delete the version that has the same (original) name as the original in the parent class question bank.
- Delete the edited/modified version of the question bank.
The system automatically restores the parent class version of the matching question bank.

### Table 2: Editing and Naming Implications

<table>
<thead>
<tr>
<th>Edits</th>
<th>Link Status</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>No edits to Question Bank and Assignments</td>
<td>Link maintained</td>
<td>Changes from the parent class are visible in the child class</td>
</tr>
<tr>
<td>Edit a Question Bank and save it under a <strong>new</strong> name</td>
<td>Link maintained</td>
<td>Changes from the parent class are visible to the child class but do not affect the edited, child Question Bank</td>
</tr>
<tr>
<td>Edit a Question Bank and save it under the <strong>same</strong> name</td>
<td>Link is disabled</td>
<td>Changes from the parent class are not visible to the child class</td>
</tr>
<tr>
<td>Upload a course module containing a Question Bank with the same name as one in the parent class</td>
<td>Link is disabled</td>
<td>Changes from the parent class are not visible in the child class</td>
</tr>
</tbody>
</table>

### 5.4 Course Modules

Course Modules allow you to share your class content with others, including related assignments and Web resources (for example, images) used by your questions and assignments.

When you create a course module, the system packages the class elements you have identified, producing a single, installable zip file that can be archived or redistributed to other instructors using the system.

Once a course module is distributed and installed in a new class location, it does not maintain any synchronization with the original source class or its materials.

**Note:** Inherited content is not included in child class course modules.
Creating a Course Module

To create a new course module:

1. From the System Tools menu, select Course Modules.
2. Click Create.
   A table displays all the question banks, assignments, and Web folders with resources (for example, image files) for your class.
3. Select the course components to include in your new course module.
   You can highlight multiple items in a list using Shift-click (for contiguous selections), CTRL-click (for multiple individual selections), or Select All.
4. Use the arrow button to add your selections to the list of included elements for your new course module.
   You can include any combination of question banks, assignments, and Web folders in your selected list.
5. To select Web resources (for example, images and other files that are referenced by your question banks and assignments), select the folders that contain your resources. Subfolders are automatically selected.
6. When you are satisfied that the list on the right contains all the elements to include in your new course module, click OK.
7. Specify a name for your course module. Optionally, you can enter descriptions for each course component. You can also select descriptive names for any Web folders you have selected. Question bank and assignment names cannot be changed.
8. Click OK to create your course module according to the specifications you have indicated. Return to the Course Modules main menu and notice that the new course module is added to the bottom of the list of installed course modules for your class.

   Note: Click Cancel at any time to return to the Course Modules Main Menu.

Saving A Course Module

This is a required step for redistributing or installing your course into a new class.

To save a course module:

1. In the Course Modules main menu, select the course module to save to your local machine by selecting the check box adjacent to it in the list of available modules in your class.
2. Click the Save button.
   The next page displays the related URL information that is referenced in the course module you have selected. The following message about the URLs is displayed.
Your question banks are scanned for URLs beginning with the following strings. These references are replaced with a system-independent string that makes your module re-locatable to classes on other servers.

3. Click OK to continue. Typically you do not need to make changes to the system default behavior for URL replacements.

4. A file download dialog opens, allowing you to specify the download location and to (optionally) rename the file.

When the file download/save operation is complete, you are returned to the Course Modules main menu.

### Uploading and Installing a Course Module

The advantage of using course modules to manage content between classes on one or more Maple T.A. servers is that the question banks, assignments, and Web resource folders are entirely portable and can be installed in a new class very easily.

In the following discussion, the term **destination class** refers to the class in which to install the course module and the term **source class** refers to the originating class for the course module contents.

**To install a new course module into the destination class:**

1. Ensure that you have access to the saved course module from the source class on your hard drive, a network drive, or an Internet resource.
2. Click the **Upload** button from the Course Modules main menu.
3. To select a course module, click **Browse**.
4. In the **Choose File** dialog, select the course module file on your hard drive, a network drive, or an Internet resource, and click **Open**.
   
   **Note:** The course module file must be in original zip format.
5. The **Upload Module** window opens. Click **Upload** to initiate the file upload.
   
   When the course module has been uploaded successfully, the course module contents, that is, question banks, assignments, and Web folders are displayed.
   
   Elements contained in your uploaded course for which names match elements previously contained in your class are highlighted in yellow background with red type, with a warning message:

   **WARNING:** The course module you have uploaded contains resources which will overwrite components that you already have installed. The components which will overwrite your existing course components are highlighted in the table below. If you do not want these course components erased and replaced with new ones, press Cancel, or ensure that they are not selected in the table below. To proceed,
select the components that you want to install from the table below and press Install.

6. At this point you can install the new components in your class, overwriting the original components. You can also select or clear other elements of the course module for installation into your class. The default installation behavior is to install all course module elements; however, by clearing individual parts, you can choose the specific elements to install.

Click **Install** to copy and install all the selected course module elements into your destination class.

The new course module appears in the list of available course modules for your class, and all of the elements you selected appear in their respective areas throughout your class Web site. Question banks are listed in the **Question Bank Editor**, assignments appear in the **Assignment Editor**, and Web resources are displayed in the **Class Website Editor** (available from **System Tools**).

**Additional Notes**

The base class Web site folder, *web_folders* is the most common element that is flagged as a duplicate. This is a common default destination for many Web resources; however, because it is a folder name established for every course, you may already have saved your own resources to the class Web site folder in the destination course. If this is the case, you can either:

- Create a new subfolder in your destination class Web site and reinstall your resources in that subfolder.
- If you have access to the source class for the course module, you can return to the course module’s source class and move the resources in the base folder of that class Web site to a subfolder, and then recreate the course module so that it will not match with your destination class folders upon upload.

**Note:** If you change the location of your resources, make sure to update the reference to them in questions appropriately.

Ensure the following file and system requirements are met.

- The course module you upload must be in zip format.
- If you attempt to upload a zip file that is not a course module, the system generates the following error message and you must make another attempt:

  This file does not appear to be course module (it has no manifest file).
Each server has a maximum file size setting for uploads that is established by your system administrator. (The system default setting is to allow uploads of up to 1 MB.) If your file upload repeatedly times out, or if you receive a message informing you that your upload exceeds the server limit, contact your system administrator.

Inheritance of Question Banks and Assignments

If you install a course module that has a new version of a question bank with the same name as the question bank in the parent class, you permanently break the link to the parent class version of the question bank.

To refresh the content of your class to match that in the parent class or restore the link to the parent class version of the content, you must do one of the following.

- Save your new, edited question bank under a different name.
- Delete the edited/modified version of the question bank.

The parent class restores the matching question bank automatically.

**Note:** If you modify question banks or assignments that you inherit from a shared parent class, there is no risk that the parent class version will overwrite your modified version, unless you specifically delete the modified question bank or assignment from your child class. This means that if you make changes to the inherited question banks or assignments and save them to the original name, your changed versions sever the relationship with the parent asset and you will not receive any future updates from the parent class automatically. Therefore, you must inform the instructor in your shared parent class if you want to be notified of changes to parent class question banks and assignments.
6 Additional Resources

6.1 Maple Application Center

The Maple Application Center™ contains free course modules and resources for download. Many topics are covered, for example, vector spaces, symmetric matrices, orthogonality and inner products, matrix algebra, optimization, DEs, functions and relations, rational expressions, inner product spaces and eigenspaces, and more.

To access Maple T.A. resources at the Maple Application Center:

1. In your browser, navigate to http://www.mapleapps.com/.
2. Perform a search. Set the Application Type to “Maple T.A.” or a specific resource you require, for example, “Maple T.A. Question Banks.”
Index

Symbols
$\text{ANSWER}$, 21
$\text{RESPONSE}$, 21
$\$\text{ variable symbol}$, 18
.qu file extension, 7

A
adding
  question in question bank, 9
algorithmic variables
    specifying, 17
assignment editor
    overview, 31
    vs. question bank, 31
assignments
  course module inheritance, 61
  deleting, 43
  finishing, 42
  introduction, 1
  mastery, 38
  naming, 34
new, 33
saving, 42
shared, 43
shared class inheritance, 61
status, 42
study session, 38
types, 36
assignment statistics
  overview, 48
assignment tab
  choose name, 34
  review & finish, 42
  select questions, 34
  set policies, 35

B
Boolean value
  in Maple code, 19
browser buttons
  navigating, 5
  buttons
    back forward, 5

C
changing grades, 47
child class, 56, 61
Class Home Page
  instructor use of, 2
  links, 4
  proctor use of, 2
class roster
  overview, 51
  text file, 51
  uploading, 51
course module
  creating, 58
  file server requirements, 60
  installing, 59
  overview, 57
  saving, 58
  uploading, 59
  creating
    course module, 58
    Maple-graded question, 21
    shared class, 55

D
deleting
  assignments, 43
destination class
definition, 59
E
edit
  feedback, 18
  mastery policies, 39
  student information, 50
email student, 40
Equation Editor, 11
example
  multiple choice question type, 13
  question types, 13
  randomly determined parameters, 17

F
feedback, 39–40
  in question, 18
file
  maximum size, 55
  upload, 54
final grade, 40
finishing assignments, 42

G
generating reports, 46
gradebook
  add comments, 48
  administration tab, 50
  edit student information, 50
  generating reports, 46
  overview, 45
graded assessments, 36
grant permissions
  inline questions, 27
  grouped questions, 35
  guidelines
  Maple code, 19

H
headers
  advanced button, 34
help icon, 5
help system
  accessing, 5
hints
  set in question bank, 39
HTML
  in questions, 13
  Use HTML check box, 13

I
individual questions, 35
inline question
  numeric question, 26
inline questions
  authoring, 24
  configure permissions, 27
  examples, 24
  list question, 24
  overview, 23
  question types, 23
  saving, 28
  student response objects, 23
  visual editor, 23
insert
  plot, 22
installing
  course module, 59
  question bank, 12
instructor
  logging on, 4
  main menu, 5
item statistics
  overview, 49

J
Java applets
  configure permissions, 27

M
Maple-graded question type
  guidelines, 19
  overview, 19
Maple plot
  insert, 22
mastery assignment, 38
maximum
  attempts, 41
  file size, 55
merge questions, 34
multiple choice
  (basic) question type, 13
  advanced question, 17

N
naming
  assignments, 34
navigating, 5
new assignment, 33

O
online connection, 41
opening
  question bank on hard drive, 29
P

passing score
  setting, 40
plot
  insert, 22
plot as algorithmic variable, 22
plotting
  student response, 21

Q

question bank editor
  navigate to, 8
  overview, 8
question banks
  .qu file, 7
  adding a question, 9
  adding a topic, 9
  course module inheritance, 61
  introduction, 1
  overview, 7
  process, 9
  saving & installing, 12
  shared class inheritance, 61
  starting new, 9
  uploading, 28
question mark
  help icon, 5
questions
  per page, 41
  selecting, 34
question type
  examples, 13
  Maple-graded, 19
  multiple choice (basic), 13
  overview, 10

R

removing
  shared class, 56
requirements
  course module, 60
  roster, 51

S

saving
  assignments, 42
  course module, 58
scheduling assignments, 41
scramble questions, 34
selecting
  questions, 34

semicolon
  in algorithmic variables, 18
  in Maple-graded questions, 19
send reports, 40
set policies tab, 39
setting policies, 35
shared class
  creating, 55
  removing, 56
  updates, 56
shared parent class, 61
source class
  definition, 59
SRO, 23
SRO properties panel, 23
student response objects, 23
students
  visiting class home page, 1
student statistics
  add comments, 48
  changing grades, 47
  overview, 46
  question weighting, 47
study session, 38
system tools
  overview, 53
  Website editor, 54

T

test and review question, 14
text file
  class roster, 51
time limit, 40
tool tips
  Main Menu, 5
topic
  in question banks, 9
types of assignments, 36

U

uploading
  class roster, 51
  course module, 59
issues with question banks, 29
overview (files), 54
procedure for class roster, 52

V

variable symbol, 18
visual editor
  overview, 23
W
Website editor, 54